
 

    

 

 

 

1

 

1

 

Late-Breaking News 
About Logic Pro 7

 

This document contains information about additions and 
changes made to Logic Pro 7 after the manuals were 
completed.

 

Some are new or updated features, and others are corrections or changes to names, 
operations, or functionality. Please read this documentation carefully, as some of the 
information may supercede that of the Reference manuals. For the latest information 
about product updates, tips, and techniques, visit the Logic Pro website at 
http://www.apple.com/logic.

 

General Changes

 

This section outlines global menu and operational changes.

 

Parameter Boxes

 

All parameters that only have two states (on/off ) have been changed into checkboxes. 
Simply click on the box to activate (checked), or deactivate (unchecked) the parameter. 
Parameters that have been updated to operate in this fashion include:

 

•

 

Region:  Loop, Clip Length

 

•

 

Chord Memorizer Object:  Cable Split

 

•

 

Arpeggio:  Repeat

 

•

 

Score:  Interpretation, Syncopation, No Overlap, Lyric

 

Menu Changes

 

File > Export > MIDI Region as Audio File was renamed to File > Export > Region as 
Audio File, as this describes the function more precisely.

The Audio > Audio Settings menu item was removed, as it was a duplicate of Logic > 
Preferences > Audio. 

The Logic > Preferences > Control Surfaces > Scan and Logic > Preferences > Control 
Surfaces > Install menu items has been moved into the local New menu of the Setup 
window (Logic > Preferences > Control Surfaces > Setup).

http://www.apple.com/logic
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The local Matrix Editor menu item View > White Background was renamed to View > 
Bright Background. 

 

Movie Audio Extraction

 

The audio track selection menu process (described in the manual) adds an unnecessary 
step when extracting audio from a movie file. If the movie file only contains one audio 
file, selection is superfluous. Use of the Options > Movies > Extract Audio from Movie 
function will automatically extract the audio (as an AIF file), and add it to the Audio 
window. The movie name will be retained, and used for the audio file. 

The Options > Movies > Extract Audio to Arrange function places the extracted audio 
(Region) onto the selected Arrange window track.

 

Preferences

 

This section outlines changes in Logic’s preferences.

 

File Format Option

 

The Audio preferences of Logic 6 allowed you to change the bit depth of freeze files 
from the default 32 bit (float) to 24, or even 16 bit. The primary intent of this option was 
to allow the use of freeze files in place of bounced tracks, given the absence of the 
Export Track As Audio File function. As Logic Pro 7 offers this functionality, the Freeze 
File Format option is no longer required, and has been removed from the Audio 
preferences. 

 

To export a track as an audio file:

 

m

 

Choose File > Export > Track As Audio File. A file selector opens, allowing you to set the 
bit depth and file name. 

The Export Track As Audio File function offers the same export functionality as the 
Freeze function in Logic 6, but track naming is more convenient and you can freely 
choose the file destination and format for each export.

 

Smart Loop Handling Option

 

In Logic’s Global > Editing preferences you will find the additional “SmartLoop handling 
of Scissor and Split by SPL “ option, which determines how Logic Pro 7 handles the 
cutting of looped Regions.

If you activate the option, you can cut the looped area of Regions (using the Scissors or 
Marquee tool or Split by SPL commands). Logic Pro 7 automatically creates Regions 
after—and if necessary—before the cut, ensuring that these areas remain identical. 
This allows you to split looped Regions without altering playback in the looped area. 

If the “SmartLoop handling of Scissor and Split by SPL” option is switched off, it is not 
possible to cut looped areas. Cutting the looped Region itself deactivates the Loop 
parameter in the Region Parameter box. 
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Song Settings

 

The Song Settings contain an additional Audio pane, which offers the following two 
options:

 

Playback Pre-Roll

 

When this option is enabled, all start commands will force Logic Pro 7 to start playback 
a little earlier (shifted to the left). The exact pre-roll value is dependent on the current 
delay compensation value for plug-ins. This option ensures that transients which fall 
exactly on the start position are played back correctly. If this option is disabled, 
transients that fall precisely on the start position can be missed, or appear to be faded 
in.

 

Pan Law

 

The Pan Law value determines the amount of volume reduction to mono signals that 
are panned to the center position. If set to 0 dB, mono signals will seem louder when 
panned to the center position, in comparison with extreme left or right pan positions. If 
set to either 

 

–3 dB 

 

or 

 

–3 dB compensated

 

, mono signals will seem equal in loudness, 
regardless of their pan position:

 

•

 

–3 dB:

 

  A full scale mono signal (0 dBfs) will have a level of –3 dB when panned to the 
center position.

 

•

 

–3 dB compensated:

 

  A full scale mono signal (0 dBfs) will have a level of 0 dB when 
panned to the center position (or +3 dB when panned to extreme left or right 
positions). 

Songs created in older Logic versions always use the 0 dB option. Please note that 
switching the Pan Law value to –3 dB will change the mix of such songs!

 

AU Manager

 

Logic Pro 7 uses Apple’s AU Validation Tool to ensure that only Audio Unit plug-ins 
which pass the test are used in Logic. 

The scan process takes place automatically when you launch Logic Pro 7. You can see 
the results of the validation scan for all Audio Units plug-ins via the Logic Application 
menu:  Preferences > Start Logic AU Manager.

 

Note:  

 

Logic Pro 7 automatically quits before the Logic AU Manager is launched. Logic 
will automatically restart after you quit the Logic AU Manager. 

The Logic AU Manager allows you to disable Audio Units plug-ins that you don’t want 
to use in Logic, even if they pass the test. Simply uncheck the corresponding checkbox 
in the Use column to disable any plug-in. You can store your choice of Audio Units 
plug-ins by clicking 

 

OK

 

.
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The results of the test are shown in the Compatibility column. Audio Units plug-ins that 
“failed” the validation test, can be enabled—but be aware that these plug-ins can 
cause problems. Use of plug-ins that have failed the validation can negatively affect the 
test results of subsequently scanned plug-ins, can cause Logic crashes or even lead to 
data loss (destroyed song files).

We strongly recommend that you check the manufacturer’s website for updated 
versions of Audio Units plug-ins that fail the validation.

 

Note:  

 

If you press Control-Shift while launching Logic, the AU Safe Mode will be used:  
Only plug-ins that pass the validation test will be used; manually activated plug-ins that 
failed the validation test will not be available.

Click “Reset & Rescan All” to run another validation test, after installing plug-ins/
updaters or moving components in the Finder, while Logic or the AU Manager are 
open. You can also rescan individual plug-ins—in cases where you’ve installed an 
updated version. Updated plug-in versions will automatically be tested the next time 
Logic is launched. They will be enabled automatically, if they pass the validation scan.

 

Loop Browser

 

The Apple Loops Browser also displays Acid and ReCycle Loops, and has therefore been 
renamed Loop Browser. Loops with sample rates that don’t match the song sample rate 
can be used.

Acid Loops don’t contain “tags” like Apple Loops. Apple Loop tags identify the 
categories/styles that a Loop appears in, within the Loop Browser.

In Acid Loops, this information is derived from the surrounding folder structure 
(especially the names of folders), which must comply with certain standards. This 
means that it’s not possible to drag an individual Acid Loop file into the Loop Browser.

As such, you need to drag the entire CD (or folder) that contains the Acid Loops into 
the Loop Browser.

The 

 

Key

 

 pop-up menu was renamed 

 

Play In

 

. The 

 

Follow Chord Track

 

 option was 
renamed 

 

Song Key

 

.

 

Display of Loops

 

All loops that follow the song key and tempo are indicated by the following symbols in 
Logic:
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Apple Loops Utility

 

If you open an Audio Region with a length that does not match the bars or beats in the 
Apple Loops Utility, the following dialog appears:

There are two possible reasons for the wrong length:

 

•

 

The audio recording was recorded at the song tempo, but not cut correctly. In this 
situation, you can shorten the recording, via the dialog.

 

•

 

The loop uses a different tempo:  in this case, you can set the length of the audio 
loop in the Loop length box and choose “Use set length.”

 

Support of Apple Lossless Files

 

Logic Pro 7 supports Apple Lossless files. This lossless file format uses an audio codec 
that retains the full quality of uncompressed CD audio, while requiring only about half 
the storage space. The Apple Lossless Encoder can be used for importing music from 
CDs in iTunes, and audio files exported or bounced in Logic can be generated in this 
format. 

 

Logic Node Application

 

The Logic Node Application can’t process Audio Units plug-ins. It is, however, possible 
to split tracks that use Audio Units into two halves. The first plug-in (and up to the last 
Audio Unit on the track) is processed locally, and remaining plug-ins (Logic native) may 
be processed on a Node. 

As an example:  Use of an Audio Units instrument which is processed with Logic’s built 
in plug-ins. The Audio Units instrument plug-in is processed on the host, and the Logic 
plug-ins are processed on a Node.

 

Loop Length Editing

 

Logic’s Loop function has been enhanced with an easy to use Loop Length Editing 
function. 

 

To set the length of a looped Region:
1

 

Move the cursor to the end of the Region that you want to loop. The cursor will change 
into a circular arrow (a loop) when positioned in the upper area of the Region.

 

2

 

Click-hold and drag the end of the Region to the desired length.
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Note:  

 

Whenever you move the cursor into the upper half of the looped area, it changes 
to a circular arrow, allowing loop length changes. If you want to select the looped 
Region (to move it, for example), click in the lower half of the looped area. You can also 
Shift-click in the upper loop area to select the Region. 

The cursor will only turn into the circular arrow (and offer the Loop Length Editing 
functions), when the track is of sufficient height. If the track height is minimal, Option-
click on the end of the Region to access the Loop Length Editing function. This also 
applies if automation data is visible on a track. 

 

Important:  

 

Deactivation of the Region Loop parameter resets the loop length. The next 
time the Loop parameter is used, the Region is repeated until it encounters another 
Region on the same track or the Song End point is reached. 

 

Create Multiple Tracks

 

This facility, accessible via the Tracks > Create Multiple menu option in the Arrange 
window, does exactly what it says. When selected, a dialog box opens, allowing you to 
choose the:

 

•

 

Driver:  This pull-down menu allows you to select the audio hardware driver that you 
wish to use for your newly-created tracks.

 

•

 

Track Type:  This pull-down menu allows you to select between 

 

Audio, Audio 
Instrument,

 

 and 

 

Auxiliary 

 

tracks.

 

•

 

Number of Tracks:  Type in the desired number of tracks. Eight is the default.

 

•

 

Mode:  Simply click on the desired 

 

Mono 

 

or

 

 Stereo

 

 radio button, to create multiple 
mono or stereo tracks of the chosen type.

The Create Multiple Tracks function is intelligent in the way it handles tracks, and 
underlying Audio Objects. To explain; imagine a song that contains four audio tracks in 
the Arrange, but there are actually eight Audio Objects set up on the Environment’s 
Audio Layer. Use of the Create Multiple Tracks function to add another four tracks to 
the Arrange will work as expected. The four existing tracks use Audio Objects 1 to 4, 
and the newly-created tracks use Audio Objects 5 to 8.

Using the same example, but adding eight tracks with the Create Multiple Tracks 
function, behaves a little differently. The four existing tracks use Audio Objects 1 to 4. 
The newly-created tracks use Audio Objects 5 to 8, and new Audio Objects (9 to 12) are 
automatically created on the Environment’s Audio Layer.

This facility makes the setup of additional tracks much faster than in previous Logic 
versions, where new Audio Objects and Arrange window tracks needed to be created, 
and assigned, before use. 
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Control Surfaces (Controller Assignments)

 

The Easy View of the Controller Assignment window has been simplified. The 

 

Control 
Name

 

 field has been removed, because Easy View is generally used for unsupported 
control surfaces—such as the controllers on your master keyboard or other fader 
boxes. 

The 

 

Track

 

 parameter allows you to choose between 

 

selected

 

 (which is the default, if 
creating assignments on the selected track) or a fixed track number (if you want to set 
up your controls as a mixer surface). 

The

 

 Learn Message

 

 button has been renamed to

 

 Learn Mode

 

 (because you can create 
multiple assignments while it’s enabled).

Assignments created for a specific plug-in are only active if the plug-in is present on 
the specified track. This enables you to use the same controller messages for different 
plug-ins—control the cutoff frequency of ES1, ES2, or EXS24 via the same knob—
depending on which software instrument is inserted in the selected track.

Your assignments are stored as preferences, making them available in all songs.

 

Updated File Paths

 

The location of all files (preferences, plug-in settings and so on) associated with 
Logic Pro 7 have changed. Unlike older versions, Logic Pro 7 does not use the program 
folder as the location for any associated files. 

Logic Pro 7 complies fully with Mac OS X standards:

 

Pre Installed Files

 

All pre-installed files are located in the 

 

local domain

 

: 

 

YourHardDiskName 

 

It is usually prefaced with a:  / (at the beginning of a path).

 

User Created/Editable Files

 

All files that can be directly written by the user are located in the 

 

user domain

 

:

 

YourHardDiskName/Users/YourUserName.

 

It is usually prefaced with a:  ~/

 

Preferences

 

All preference files are installed in:  ~/Library/Preferences/Logic
The main preference file is named:  com.apple.logic.pro
Other Logic Pro 7 preference files and the Project Manager database folder are also 
found in this folder.

 

com.apple.LogicNodes.plist

 

This preference file contains information about Logic Nodes that were previously 
connected to your system.
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Song Templates

 

Logic Pro 7 scans for a folder named “Song Templates” in the following folder:
~/Library/Application Support/Logic.
Logic Pro 7 then searches for the “Autoload” or “Autoload.lso” song in:
/Library/Application Support/Logic.

 

Plug-in Settings

 

Logic Pro 7 scans for a folder named after the plug-in (“PlugInName/“) in the following 
folders, and order:

 

•

 

~/Library/Application Support/Logic/Plug-In Settings
User-defined or edited settings are always stored here. These settings appear in the 
top level of the Settings pop-up menu in Plug-in windows. “Save Setting as” defaults 
to this level. “Save Setting” only works on settings located at this top level (otherwise 
a “Save Setting as” is performed).

 

•

 

/Library/Application Support/Logic/Plug-In Settings
Factory settings are installed here. If Logic Pro 7 also finds settings in one of the 
other locations, the settings found here appear in the “Factory” subfolder of the 
Settings menu. 

 

•

 

/Applications/Logic 6 Series/Plug-In Settings
The setting files of the Logic 6 Series were always stored here. If Logic Pro 7 also finds 
settings in one of the other locations, the settings found here appear in the “Logic 6 
Series” subfolder of the Settings menu. 

We recommend that all old settings be moved from this folder to the new location for 
user settings (~/Library/Application Support/Logic/Plug-In Settings). You can do this 
with a drag and drop in the Finder, or in Logic; by loading the settings, and saving 
them to the new location (which is the default location of the “Save” or “Save as” 
dialogs). 

 

Default Settings

 

Like earlier versions, Logic Pro 7 allows you to use a default setting file that 
automatically loads when opening a plug-in. This file must be named “#default.pst”, and 
is searched for in:  ~/Library/Application Support/Logic/Plug-In Settings/PlugInName.
This is where you can save your own default setting. Simply save a setting called 
“#default.pst”. 

If not found, Logic Pro 7 looks in /Library/Application Support/Logic/Plug-In Settings/
PlugInName/ and then /Applications/Logic 6 Series/Plug-In Settings/PlugInName.

 

GarageBand Instruments

 

Logic Pro 7 searches for GarageBand Instruments in the:  “Plug-In Settings/PlugInName” 
folder in the following directories, and order:

 

•

 

~/Library/Application Support/Logic/Plug-In Settings/PlugInName
User-defined or edited settings are stored here.
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•

 

/Library/Application Support/GarageBand/Plug-In Settings/PlugInName
“Factory” settings are stored here.

 

Channel Strip Settings

 

Logic Pro 7 scans for a folder named “Channel Strip Settings” in the following folders, 
and order:

 

•

 

~/Library/Application Support/Logic
User-defined or edited Channel Strip settings are stored here.

 

•

 

/Library/Application Support/Logic
Factory settings are always stored here.

Logic Pro 7 also scans the following folder path for Track and Instrument Audio Objects:
/Library/Application Support/GarageBand/Instrument Library/Track Settings.

 

EXS Instruments

 

Logic Pro 7 scans for a folder named “Sampler Instruments” in the following folders, and 
order:

 

•

 

~/Library/Application Support/Logic
User-defined or edited instruments are stored here.

 

•

 

/Library/Application Support/Logic
Factory EXS Instrument files are installed here.

 

•

 

/Applications/Logic 6 Series
EXS Instrument files of the Logic 6 Series are always stored here.

 

•

 

…/SongOrProjectName
As in earlier versions, Logic Pro 7 also searches for EXS Instruments in the project or 
song folder.

Logic Pro 7 also looks in:
/Library/Application Support/GarageBand/Instrument Library/Sampler. 

 

EXS Sample Conversion

 

These are the default locations for converted samples of different formats:

 

•

 

~/Library/Application Support/Logic/AKAI Samples
For samples converted from AKAI format.

 

•

 

~/Library/Application Support/Logic/DLS-Giga Samples
For samples converted from GigaSampler/GigaStudio format.

 

•

 

~/Library/Application Support/Logic/SoundFont Samples
For samples converted from SoundFont format.

 

Space Designer

 

Logic Pro 7 scans for a folder named “Impulse Responses” in the following folders, and 
order:

 

•

 

~/Library/Application Support/Logic

 

•

 

/Library/Application Support/Logic

 

•

 

…/SongOrProjectName
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Ultrabeat

 

Logic Pro 7 scans for a folder named “Ultrabeat Samples” in the following folders, and 
order:

 

•

 

~/Library/Application Support/Logic

 

•

 

/Library/Application Support/Logic

 

•

 

…/SongOrProjectName

 

Apple Loops Library

 

Logic Pro 7 shares the Apple Loops Library with GarageBand. It uses the Apple Loops 
folders found in these locations:

 

/Library/Application Support/GarageBand

 

Used for the Apple Loops library that ships with Logic Pro 7 or GarageBand. The 
content of any additional Jam Pack libraries is also installed here.

 

Important:  

 

Don’t delete this folder—even if you decide to remove GarageBand from 
your hard disk! At least be aware that this will also remove content from Logic’s Loop 
Browser.

 

~/Library/Application Support/GarageBand

 

Used for user-created Apple Loops made with the Apple Loops Utility (which might 
also be named “Soundtrack Loop Utility”—found in your Utilities folder inside the 
Applications folder).

Apple Loops dragged from the Finder into Logic’s Loop Browser window, coupled with 
the “Copy to Library” option, copies the Apple Loops to this location. Alternatively, 
additional Apple Loops can be kept in their original Finder location.

 

User Icons

 

~/Application Support/Logic/Images/Icons
The format for user icons remains .png. The filename needs to start with xxx (where xxx 
is a 1 to 3 digit number). Correspondingly numbered default icons will be replaced by 
your personal icons.

 

I/O Labels

 

The user-definable I/O Labels (the “IO Labels CoreAudio” file) are located in:
~/Library/Application Support/Logic.

This is the automatic file save location. If not found, Logic Pro 7 also searches:
/Applications/Logic 6 Series.

 

Control Surface Plug-ins

 

Control Surface plug-ins are installed (and searched for) in the application bundle.

You can install additional Control Surface plug-ins in:
~/Library/Application Support/MIDI Device Plug-ins.
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Tuning Tables

 

Logic Pro 7 scans for a folder named “Tuning Tables” in the following folder:
/Library/Application Support/Logic.

 

DNA Grooves

 

Logic Pro 7 scans for a folder named “GROOVES” in the following folders, and order: 

 

•

 

~/Library/Application Support/Logic

 

•

 

/Library/Application Support/Logic

 

•

 

Applications/Logic 6 Series

 

Default Directories

 

•

 

~/Music/Logic
For Logic Pro 7 songs (Open/Save/Save as).

 

•

 

~/Movies
For Movie files (Open).

 

•

 

~/Pictures
For the Camera tool in the Score Editor (Save Bitmap File as).

 

Plug-in Changes

 

This section outlines changes and additions made to Logic’s effect and instrument 
plug-ins.

 

Sculpture

 

The following information supplements the Sculpture documentation in the Logic Pro 7 
Plug-In Reference.

 

Additional Body EQ Models

 

Sculpture incorporates the following additional 

 

Body EQ

 

 models:

 

Long Name Short Name

 

Western Guitar 1 Wst Guit 1

Western Guitar 2 Wst Guit 2

Semi-Acoustic Guitar SemiAcGuit

Dobro Guitar Dobro Guit

Banjo Banjo

Mandolin Mandolin

Ukulele 1 Ukulele 1

Ukulele 2 Ukulele 2

Kalimba Kalimba Bd

Double Bass 1 Dbl Bass 1

Double Bass 2 Dbl Bass 2
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The Guitar 1 and Guitar 2 Body EQ models have been renamed to Acoustic Guitar 1 (Ac 
Guit 1) and Acoustic Guitar 2 (Ac Guit 2).

Ultrabeat
The following updates the information in the Ultrabeat chapter of the Logic Pro 7 
Plug-In Reference.

Importing Drum Voices and Sequences
Ultrabeat allows you to import drum voices and sequences from other Ultrabeat 
settings into your currently active drum kit. This can be done by clicking on the Import 
button in the upper area of the Ultrabeat interface. Use the ensuing file selector box to 
open the desired Ultrabeat setting that you wish to import drum voices and sequences 
from. 

A list of all drum voices found in the setting is displayed in the “import drawer” beside 
the mixer/assignment section. A Control-click on a drum voice opens a contextual 
menu that contains the following entry:
• Copy Drum Voice + all Seq.—This command copies the drum voice and all 24 of its 

sequences—empty or not—into the Clipboard. 

As the next step, Control-click on the target drum voice in the mixer/assignment 
section. A contextual menu with the following entries will open:
• Copy (Voice & Seq)
• Paste Voice
• Paste Sequence > (submenu)
• Swap with Clipboard
• Init > (submenu)

The two Paste commands replace the corresponding data of the target drum voice. 

Select Paste Voice to replace the target drum voice, without changing its sequences. 

The Paste Sequence submenu replaces all, or individual sequences, of the target drum 
voice. Paste Sequence has no impact on the target drum voice. Pasting a single 
sequence replaces the currently active sequence (as shown in the sequencer pattern # 
field) of the target drum voice. This allows you to import drum voice sequences into 
any of the 24 possible pattern locations.

Cello 1 Cello 1

Cello 2 Cello 2

Violin 3 Violin 3

Bass Flute Bass Flute

Alto Flute Alto Flute

Long Name Short Name
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Note that these are single voice based operations, all sequence and voice data of the 
other 24 drum voices remain untouched. This is why we talk about sequences as 
opposed to patterns. Patterns contain data for all 25 Drum Voices. You should also note 
that importing is a “downstream” process—you can copy and paste data from the 
imported Ultrabeat Setting into your current Setting, but not vice versa.

The other context menu entries in the mixer/assignment section work as follows: 
• Swap with Clipboard swaps the content of the Clipboard with the target drum voice. 

As this command swaps both Drum Voice + Sequence data, it’s very useful for 
reorganization of your drum kit.

• The Init submenu contains a few starting-point (Init) sounds. Selecting one of them 
will replace the target Drum Voice.

Auditioning Sample Based Sounds
You can preview a sound by clicking on its name in the Import List, prior to importing 
it. If you would like to import a sound that contains samples, double-click on its name. 
This difference in methodology is due to the following:  An Ultrabeat setting contains 
25 drum sounds, each of which can contain up to 16 samples. If all samples were 
loaded into your computer’s RAM when a setting was chosen in the Import menu, 
Ultrabeat would spend a lot of time loading them into memory. The more user-friendly, 
and faster, solution is to only load the samples of the drum sounds you either; want to 
import or audition. The double-click works in the following fashion when importing a 
drum sound that contains samples:  the first click loads the samples into RAM, the 
second click starts playback. 

HMT Tuning
Ultrabeat is designed as a drum synthesizer and does not respond to the global 
Hermode Tuning settings. 

EXS24 mkII
The following information supplements the EXS24 mkII section in the Logic Pro 7 
Plug-In Reference.

Vel Offset parameter
The Vel Offset parameter—found towards the top left of the EXS24mkII GUI—offsets 
the incoming MIDI note velocity value by ±127. This limits or expands the dynamic 
response of the EXS24 mkII to incoming note events.
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Previewing Samples in the Load Sample Window
The EXS24 mkII offers a Play button in its Load Sample dialog, which allows audio files 
to be previewed before loading. 
• Press the Play button to loop playback of the currently selected sample file. 
• Pressing the button again stops playback.

You can audition multiple files by pressing Play once, and then stepping through the 
files.

Note:  If you activate the “Hide used Audio Files” option, files used in the currently 
loaded EXS Instrument are dimmed.

Previewing the audio file in the EXS instrument
The “Preview audio file in EXS instrument” option temporarily replaces the sample files 
in the currently selected zone. The zone is not directly triggered by activating this 
option, but it can be triggered via MIDI notes while the Load Sample dialog is open 
and different files are being selected. The selected sample can be heard as part of the 
zone, inclusive of all synthesizer processing (filters, modulation, and so on). Once you 
find a sample you’d like to use, click Open to load it. Click Cancel to return to the 
previously loaded sample. 

EVP88
Logic’s global Tuning settings will be added to the EVP88’s Lower and Upper 
parameters, which can be used to stretch the tuning in the bass and treble ranges.

Grooveshifter
The Grooveshifter plug-in allows you to rhythmically vary recordings, imparting a 
“swing” feel to the track. Imagine a guitar solo played in straight eighth or sixteenth 
notes. The Grooveshifter can make this straightforward solo swing. 

Note:  Grooveshifter is reliant on “perfect” matching of the Logic song tempo with the 
tempo of the treated recording. Any tempo variations will deliver less precise results.

The reference tempo is the song tempo. The Grooveshifter will automatically follow all 
song tempo changes.

The Parameters of the Grooveshifter
The Tonal and Beat buttons switch between two algorithms, each optimized for 
different audio material that the Grooveshifter plug-in can process. Beat uses an 
algorithm optimized for percussive input material. Tonal uses an algorithm optimized 
for tonal input material. As this algorithm is based on granular synthesis, it offers an 
additional Grain slider, which allows you to set the size of the grains—and therefore 
the precision of the analysis.
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The Swing parameter determines the amount that even beats will be delayed. A value 
of 50% means “no swing,” which is typical for most pop and rock music styles. The 
higher the values, the stronger the swing effect.

The Grid parameter determines the beat division reference used by the algorithm to 
analyze the audio material. Choose 1/8th if the audio material contains primarily eighth 
notes and 1/16 if it contains mostly sixteenth notes. 

The Accent parameter raises or lowers the level of the even beats, accentuating them. 
Such accents are typical of a variety of rhythmic styles, such as swing or reggae. 
Experiment a little to find the right setting for your song.

Match EQ
The Match EQ offers an additional sidechain input that is used for Template Learn 
mode, if active.

Pitch Correction
The Detune parameter detunes the incoming signal by the set value. 

Manual Corrections
The following section contains a number of manual corrections where functionality 
was altered after writing, or was incorrectly documented.

Relative Snap function
The Logic Pro 7 Reference manual states that Snap functionality is “absolute,” resulting 
in Regions being automatically aligned to bars, beats, and so on. This is incorrect. The 
Snap functionality is relative, which means that Regions will be aligned to the nearest 
bar, beat, and so on, distance from their original positions. As an example, if a Region is 
placed at position 1.2.1.0, and you move the Region forward (with Snap set to Bar), it 
will be repositioned at 2.2.1.0—rather than 2.0.0.0.

Freezing tracks using DSP-card based effects
The Logic Pro 7 Reference manual incorrectly states that you cannot freeze tracks that 
make use of DSP-card based effects (PowerCore and UAD1, for example). You may 
freeze such tracks. 

Opening non-floating Plug-in window
The Logic Pro 7 Reference manual (page 272) states that Shift-double-clicking a used 
Insert slot will open a non-floating Plug-in window. This is incorrect. The correct 
shortcut is Control-Option-double-click.

Sources and Destination headers EXS24 mkII chapter
The Sources and Destination headers at the top of the EXS24 mkII modulation table on 
page 552 of the Logic Pro 7 Plug-In Reference manual have been swapped.



  

Exporting Logic 4.8 songs
The Logic Pro 7 Reference manual discusses the export of Logic 4.8 format songs. This 
cannot be done directly in Logic Pro 7. You can, however, use Logic 6.4.3 to open a 
Logic Pro7 song, and use the Logic 4.8 Export function available in this Logic version 
(6.4.3).
Warning:  It should be noted that some data (such as automation) will be lost during an 
export to a Logic 4.8 song.
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